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COAO001 Information About Changing Your Address

Change Your Address

socialsecurity.gov

= Information About Changing Your Address

You can change your «» You get Social Security disability, retirement, or survivors benefits.
address andlor « You live in and are moving to an address in one of the 50 states, the District of Columbia, Puerto Rico,
telephone number at the U.S. Virgin Islands, Guam, the Northern Mariana Islands, or American Samoa, and

this web site if- + The address change is for your own benefit or payment.

If you have a foreign. APO, or FPO address, see Service Around the World

If you receive Supplemental Security Income, you cannot use this online service.
If you are a Represeniative Payee, you cannot use this online service.

For more information, see the Frequently Asked Questions .

What You Will Need + Your complete new address, including zip code. If you don't know your zip code, please check the United
States Postal Service Zip Code directory before continuing.
« Your new phone number or & number we can use to contact you, if this has changed.

What To Expect « To protect everyone's privacy, each person who wants to change his or her address must request it.
For example, your spouse and other members of your household will need to each log on to do this.
« You can decide when your change of address will take effect.
+ There are time limits for your work on each page. You will receive a warning after 25 minutes. and you
will be able to extend your time on the page. After the third warning on a page, you must move o
another page or your time will run out, and your work on that page will be lost.
« [f you have tumned JavasScript off in your browser, you will not receive any warnings.

For more information about the Change Your Address application process, please see the Internet Security
Policy .

Block access to your  If you want to prevent online and automated telephone access to your personal information, you can block
personal information access to your personal information.

WhatDo You Wantto | Use my Social Securty password to change my address )
Do?

[ Change my address without using a Social Security password ]

COA002 Acknowledgement for change of Address Services



Change Your Address

ocialsecurity.gov

Acknowledgement for Change of Address Services

Any person who knowingly and wilingly makes any representation

1. that is false to obtain information from Social Security records, and/or
2. that is intended to deceive the Social Security Administration as to the true identity of an individual,

could be punished by a fine or imprisonment, or both.

| have read the above statement and am the individual to whom the Change of Address information applies.
Cancel

COAO003 Public Agreement



socialsecurity.gov

Change Your Address

The Privacy Act
Statement

Paperwork Reduction
Act Statement

“ = Public Agreement

Social Security provides this website for your convenience. You can only use it to change your address or
telephone number.

Social Security is allowed to collect the facts on this form under Section 205 of the Social Security Act. We
need these facts to quickly identify who you are and provide the information you requested. Giving us these
facts is voluntary. However, without them we may not be able to give you the information that you want. The
Social Security Administration will not use the information for any other purpose. If you want to read more
information on this subject, read The Collection and Use of Information From Your Application.

This information collection mests the requirements of 44 U.S.C. 3507, as amended by section 2 of the
Papenwork Reduction Act of 1995. You do not need to answer these questions unless we display a valid
Office of Management and Budget (OMB) control number. The OMB control number for this form is 0960~
0596; expiration date 09/30/2009. We estimate that it will take about 10 minutes to read the instructions,
gather the facts, and answer the guestions. You may send comments on our time estimate above to: SSA,
1338 Annex Building, Baltimore, MD 21235-0001. Send only comments on our time estimate to this
address, not the completed form.

By using this website, you agree to its limitations.

==

COAO004 The Collection and Use of Information from Your Application



Socal Security Online

socialsecurity gov

The Collection and Use of Information from Your Application
Although the information you furnish on the application is rarely used for any other purpose than stated, there is a possibility that information may be disclosed to another person or to another governmental agency as
follows: (1) to comply with Federal laws requiring the release of information fram Social Security records and (2) a request from a Congressional office or the Office ofthe President.

We may also use the information you give us when we match records by computer. Matching programs compare our records with those of other Federal, State or local government agencies. Many agencies may use
matching programs to find or prove that a person qualifies for benefits paid by the Federal government. The law allows us to do this even if you do not agree o it

Explanations about these and other reasons why information you provide us may be used or given out are available in Social Security Offices. If you want to learn more aboutthis, contact any Secial Security Office

COAO006 Your Information



Socal Security Online

socialsecurity gov

Form Approvad: OMB No. 0360-0558
Expires 03/20/2008

Please Enter Your Information

Ifyou are navigating using only the keyboard or using an assistive device and need help, visit our instructional page for alternative views and
navigation.
Warning: If you select this link, you will leave this secure site and go to @ new browser window. You will automatically return to this page when you
close the new browser window.

To start your request, we need to verify your identity.

Your Social Security Number:

Use your own number even if you are receiving benefits as a

spouse, child, or parent on another person's record.

First Name:

Enter Your First Name

Middle Initial:

Enter Your Middle Initial

Last Name:

Enter Your Last Name

Suffix: -
Select A Suffix (if any)

Other Last Name:

Date of Birth: - - -
Were you born in the United States or its territories © Yes © No
or possessions?

Place of Birth:

Ifyes, please select a state, US Territory or Commonwealth from

the drop down list

Mother's Maiden Name:

(Last Name Only)

If unknown, type "Unknown” or “unk™in the field

Enter the amount, in whole dollars, of the last $ .00
payment you received from Social Security:

You can find this amount on your most recent bank statement if

you are receiving direct deposit, or on the check itself if you receive

a check by mail.

Example: If the amount of your last payment was $123 50, the

amountyou should enter is 123 (do not include commas or cents).

Does anyone else in your household also need to = Yes = Ho © Hot Applicable
report a change of address?

If so, that person can sign in after you are finished. Ifyou are a
Representative Payee, this online service will change your

address but notthose of the people you represent

COAO007 Your New Address



Socal Security Online

socialsecurity gov

Welcome Roger Field!

Your New Address
Please enter your new address
Street Address Line 1:
Street Address Line 2:
Street Address Line 3:
Street Address Line 4:
City, State, Zip Code: -

Your New Phone Number
Please enter your new phone number.
Phone Number: { )
Ifyour phone number has not changed, leave blank and select ‘Not
changed.
This phone number is:
' Home
 Wark
' Mobile
 Attorney
2 Other
I have no telephone number
 Not changed
E-Mail Address (Optional):

Cancel

COA008 When Will This Change Happen



Socal Security Online

socialsecurity gov

When Will This Change Happen

Letus know how soon you want this change of address or telephone number to take effect. You can change your address or telephone number now, or up to three months before you move.
When do you want this change to take effect?

Make the change effective

If you have your check mailed to you, it may take up to 3 weeks to change your address on your benefit check. If you are changing your address
immediately, your next check may still go to your old address.

COAO009 Verify Your Information



Socal Security Online

socialsecurity gov

Verify Your Information

You are about to change your address andior phone number. Please check the information below to make sure itis correct. It takes up to three business days to change our records. If you wish to submit additional
information or update the information submitted, you cannot make any changes for three business days

Ifthe information below is correct, select 'Confirm’ to send your request to Social Security.

Address:
123 Main Street
Baltimore, MD 21212

Phone: (410) 456-4562 This is your home phone number

Email Address:

Date: This change will take effect on 02/27/2009.

COAO010 Confirmation



Socal Security Online

socialsecurity gov

Confirmation

Thank you Roger Field!

We have received your change of address and/or phone number on February 25, 2009. A confirmation letter from Saocial Security will be sentto your old address in a few days. If you are changing your address immediately,
any notice andior your next check may still go to your old address. Please also contact the U.S. Postal Service to register your change of address.

We suggest that you use your browser commands to print or save this page for your records.

Your new address andfer phone number are listed below.

Address: 123 Main Street
Baltimore, MD 21212
Phone: (410) 456-4562 This is your home phone number

Email Address:
Date: This change will take effect on 02/27/2009.

COAO011 The Next Person’s Turn



Socal Security Online

socialsecurity.gov

The Next Person's Turn

Your change of address and/or phone number has been processed successfully. You indicated that another person in your household also needs to change his or her address. That person may do so now, or come back
another time to give us his or her information

Does the next person want to do this now? = Yes T Ho

COAO012 Change of Address Survey



Socal Security Online

socialsecurity gov
Change of Address Survey
We would like to know what you think of this online service. Please take a minute to fill out our survey below. If you do not wantto fill outthe survey, you may leave this site by using the Finished button below.

Ifyou need additional information:

e Callus at1-800-772-1213, Monday through Friday between 7 am. and7 pm
» |fyou are deaf or hard-of-hearing, call our toll-free TTY number, 1-800-325-0778, Monday through Friday between 7 a.m. and 7 p.m.
 Visit your local Social Security Office

Was it easy to find the "Change Your Address" “ Yes = No
service from our Home Page?

Was it easy to understand what information you “iYes @ Ho
needed to provide?

Were the instructions easy to understand? “Yes < Ho
Did we tell you everything you needed to know “Yes ©Ho
about your Change of Address request?

Overall, did you think it was easy to complete your “ Yes ' Ho
request for Ghange of Address?

Would you do business with us online again based “Yes ©lo

on your experience today?

COAO013 Frequently Asked Questions



Socal Security Online

socialsecurity gov

Frequently Asked Questions
Why do | need to keep my address and telephone number current?
To ensure prompt delivery of Social Security benefits, SSI payments and correspondence
What should | do if | live in another place for part of the year?

You can use this application to change your address any time, even if you relocate for part of the year. For example, if you live in a different place during the summer than you do in the winter - you can change your address
each time you relocate

I plan on moving in a few weeks, should | wait to change my address?
Mo, you can report a future change of address

How will | know the change has taken effect?
You will receive a confirmation screen atthe end of your report notifying you of the effective date of the change. In addition, you will receive a confirmation letter in the mail

How do | change my address with other government agencies?
www.socials ecurity goviotheraddress html

MSGO051 Cookies Not Enabled



socialsecurity gov

Cookies Not Enabled

To use this application, you must enable "cookies™ on your computer. We use "session cookies” that we store on your computer only during your visit. The session cookie keeps you from losing information you've entered for

a business transaction with us if, during your visit, you leave our website and return
Once you turn off your computer or stop using the Internet, the cookie is erased.

To enable cookies, follow the instructions below for the browser you're using.
Microsoft Internet Explorer 6.0+

o Select"Internet Options” from the Tools menu

& Click on the "Privacy” tab.

» Click the "Default” button (or manually slide the bar down to "Medium”) under "Settings™
® Click "0K".

Microsoft Internet Explorer 5.x

» Select"Internet Options™ from the Tools menu

« Click on the "Security” tab.

« Click the "Custom Level” button

& Scroll down to the "Cookies™ section.

» Set"Allow cookies that are stored on your computer”to "Enable”
o Set"Allow per-session cookies™ to "Enable”.

® Click "0K".

Mozilla Firefox (1.0 final release and earlier)

* Gotothe "Tools” menu

& Select "Options™.

o Selectthe "Privacy” icon in the left panel

& Checkthe box corresponding to "Allow sites to set cookies™.
« Click "OK" to save changes

Netscape 7.1/Mozilla 5.0

& Select"Preferences” from the Edit menu

Click on the arrow next to "Privacy & Security” in the scrolling window to expand.
Under "Privacy & Security”, select "Cookies.”

Select"Enable all cookies™

Click "OK.

Microsoft Internet Explorer 4.x

« Select “Internet Options™ from the View menu.

« Click on the "Advanced” tab

« Scroll down to find "Cookies™ within the “Security” section.
o Select"Always accept cookies™

& Click "OK".

Netscape Communicator 4.x

® Select"Preferences” from the Edit menu

« Find the "Cookies™ section in the "Advanced" category.
o Select"Accept all cookies” (or "Enable all cookies™).

& Click "OK".

Start Over



MSG021 How to Update Your Address or Telephone Number If You
Cannot Change It Online

Security Online

socialsecurity.gov

How to Update Your Address or Telephone Number If You Cannot Change It Online

We're sorry you cannot change your address or telephone number online. You must call or visit us to change your record. If you are —

& in the United States, you can —
o call us at 1-800-772-1213 Monday through Friday between 7 am.and 7 p.m
o call our toll-free TTY number, 1-800-325-0778, if you are deaf or hard-of-hearing, Monday through Friday between 7 a.m. and 7 p.m., or
o visit your local Social Security office. You can get directions and a map to your local Social Security office by visiting the Field Office Locator

» outside the United States, you can contact —
o your nearest Social Security office,
o the closest U.S. Embassy or consulate, or
o the Veterans Affairs Regional Office (VARO) in the Philippines.

‘Warmning: If you select any of the links above, you will leave this secure site and go to the copy of these pages on a new browser. You will automatically
return to this page when you close the new browser

55A Home



MSGO001 Internet Security Policy

Security Online

Internet Security Policy
Is it safe to transmit information to the Social Security Administration over the Internet?

SS8Ais taking all reasonable and proper measures, including encryption, to ensure that your personal infarmation is disclosed only to you. However, the Internetis an open system and there is no absolute guarantee that
others will notintercept the personal information you have entered or requested and decrypted. Although this possibility is remote, it does exist.

What is encryption?

Encryption means that all information relating to you and your account is scrambled and locked with a mathematical key during the electronic transfer. Most browsers have an icon such as 3 key or a lock to represent an
encrypted mode or session. A broken key, open lock, or no lock indicates that the session or mode is not encrypted.

Why is special software necessary to access the Internet application?

So that your online request can remain confidential, SSA uses a security protocol (method) called Secure Sockets Layer (SSL) for this application. You must use a Web browser that supports SSL. Netscape Mavigator and
Microsoft Internet Explorer are two browsers that support SSL. Using this security protocol, all information sent between your computer and our server is encrypted before being sent on the Internet

Why SSL?
SSL provides a high level of security and is the security protocol supported by more browsers than any other Itis estimated that about 92% of Web browsers have an SSL browser available for their use
| have the right software and | am trying to connect during your posted business hours, but | still cannot access your form. Why?

‘We have found that a number of business, government, and educational networks do not have their firewalls configured to allow passage of secure Web traffic Check with your systems administrator to determine if this is
the case atyour site. If this is the case you will not be able to access this application web site.

Close this window to continue your request.



MSGO002 The Information You Entered Does Not Match Our Records

Sodial Security Online

socialsecurity.gov

The Information You Entered Does Not Match Our Records

Please check this infarmation

» Ifyou typed the wrong information, you will need to correct it before continuing
« |fthe information is correct, contact Social Security. Be sure to tell the representative that you tried to complete your request online.

To contact Social Security;
« Call our toll-free number, 1-800-772-1213. Explain that you are unable to complete your request online. If you are deaf or hard of hearing, call our toll-free "TTY" number, 1-800-325-0778. Representatives are available
Monday through Friday from 7 am.to 7 p.m
« Gotoyour local Social Security office and tell the representative that you were unable to complete your request

5S5AHome




MSG004 The Information You Entered Does Not Match Our Records

Sodial Security Online

Change Your Addre

vevrw socialsecurity. gov

The Information You Entered Does Not Match Our Records
Ifthe information that you provided is correct, then it may be necessary to correct your Social Security record
To resolve the discrepancy:
« Call our toll-free number, 1-800-772-1213. If you are deaf or hard of hearing, call our toll-free "TTY” number, 1-800-325-0778. Representatives are available Monday through Friday from 7 am.to 7 p.m
o Call orvisit your local Social Security office.

854 Home

Back.



MSGO006 This Service Is Not Available At This Time

Sodial Security Online

Change Your Addre

v.socialsecurity gow

This Service Is Not Available At This Time

This senvice is available during the following hours (Eastern Time):

Monday through Friday: 5:00 AM - 1:00 AM
Saturday: 5:00 AM - 11:00 PM

Sunday. 2:00 AM - 10:00 PM

Holidays: 5:00 AM - 11:00 PM

SS5A Home



MSGO037 Unable to Process Your Request

Sodial Security Online

socialsecurity.gov

Unable to Process Your Request

Ifthe information you gave us is correct, we're sorry but this service is not available to you

Ifthe information you gave us is correct and you are currently receiving benefits, online access to your account may be blocked. For assistance, please call us at 1-800-772-1213, Monday through Friday between 7 a.m. and
7 p.m. If you are deaf or hard-of-hearing, call our toll-free TTY number, 1-800-325-0778, Monday through Friday between 7 am. and 7 p.m

SS5A Home

Retum to Online Services



MSGO008 We Are Processing Your Request

S s e Change Your Address

vevrw socialsecurity. gov

We Are Processing Your Request...



MSGO005 We Cannot Process Your Request At This Time

Sodial Security Online

socialsecurity.gov

We Cannot Process Your Request At This Time

We are sorry for the inconvenience, butwe cannot process your request at this time.

Ifyou still wish to complete your request online, you may try again later. If you want to know about other options for completing this request, you may call 1-800-772-1213 or contact your local Social Security office. If you are
deaf or hard of hearing, call our toll-free "TTY" number, 1-800-325-0778. Representatives are available Monday through Friday from 7 am.to 7 p.m

SS5A Home



MSGO007 You Have Reached the Limit on the Number of Requests

Sodial Security Online

Change Your Addre

v.socialsecurity gow
You Have Reached the Limit on the Number of Requests
We have not been able to match the information you entered with our records

To resolve the discrepancy:

« Call our toll-free number, 1-800-772-1213. If you are deaf or hard of hearing, call our toll-free "TTY” number, 1-800-325-0778. Representatives are available Monday through Friday from 7 am.to 7 p.m
o Call orvisit your local Social Security office.

854 Home



MSGO003 Your Session Has Expired

Sodial Security Online

vevrw socialsecurity. gov

Your Session Has Expired

We are sorry for the inconvenience but your session has expired.

If you would like to continue completing your request enline, you may sign in again by selecting the button below.

854 Home

Retum to Report
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